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1

Introduction

If you’ve never seen a PowerPoint presentation, you’re in a pretty select group.
With legions of folks all over the world pounding out an estimated 30 million
PowerPoint slides every day, PowerPoint’s the runaway leader in the field of presen-
tation programs, leaving competitors like Corel Presentations and Apple’s Key-
note in the dust. PowerPoint has become so ubiquitous that it’s even managed to
work its way into the English language: powerpointless, as many audience members
can attest, describes a PowerPoint presentation that has bulleted text, graphics,
animated slide transitions—everything except a good reason for existing.

So how do you improve a program that’s wildly successful? If you’re Microsoft,
you completely redesign it. That’s right: PowerPoint 2007 looks completely differ-
ent from its previous incarnation, PowerPoint 2003. Gone are the menus, wizards,
and most of the toolbars and panes that a generation of PowerPointilists grew up
with. As you see in Figure I-1, Microsoft has replaced all of that with the ribbon.
And that’s just the tip of the redesign iceberg.

The good news is you can still do the same things in PowerPoint 2007 that you
could do in earlier versions—and a few more, besides. You can still create slide-
shows that contain bulleted lists, sound and video clips, and cool animated effects.
You can still add macros and interactive buttons to your slides, and you can still
deliver your slideshows in person, over the Web, or on an unattended kiosk.

What’s new in PowerPoint 2007 is how you do all of these things.

Fortunately, you’re holding the book that Microsoft should have included in the
PowerPoint 2007 box—but didn’t. If you’re familiar with PowerPoint 2003 or an
earlier version of the program, this book will help you make the transition from
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the old, familiar way of doing things to the new, improved way. (You even see tips
and tricks that were buried so deep inside menus and toolbars in PowerPoint 2003
that you probably didn’t know they were there.)

On the other hand, if you’re brand new to PowerPoint—or even to presentation
programs in general—then you’re in luck, because this book shows you how to
build basic to bowl-’em-over presentations for work, school, civic organizations,
or anything else you’re involved in.

Figure I-1:
If you’re a PowerPoint
2003 aficionado, expect
to be a little shocked
when you fire up
PowerPoint 2007 for the
first time. This version’s
the biggest wholesale
change to the PowerPoint
interface in nearly a
decade, and there’s no
fallback “classic” mode,
either.

FROM THE FIELD

Presentation vs. Slideshow
Microsoft’s help files, as well as most PowerPoint books,
use the terms presentation and slideshow interchangeably.
But a very important distinction exists between the two.

A slideshow is a collection of slides but a presentation is
everything that goes into delivering the slideshow to your
audience. A presentation includes not just the slideshow,
but speaker notes, printed handouts, and—most important
of all—you, the presenter.

In other words, no matter how cool your slides are, they
aren’t your presentation. Your slides are nothing more than
tools you use to deliver your message. If you keep this dis-
tinction in mind, you’ll keep your focus on the message—
where it belongs—and off the tricky stuff you can do with
PowerPoint. For your audience’s sake, avoid bringing yet
another powerpointless presentation into the world!
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What You Can Do with PowerPoint 2007
PowerPoint was originally designed to help business professionals create and deliver
electronic slideshows (sales presentations, mostly). But over the years, as Microsoft
piled on the options, folks began discovering new ways to use the program.

Here’s a short list of what you can create using PowerPoint 2007:

• Multimedia presentations. Use PowerPoint to create slideshows that you—the
presenter—can run in front of an audience on a computer screen (for small
groups) or a digital projector (for a packed conference hall). The kinds of pre-
sentations that fit into this group include business and sales presentations,
workshop and conference sessions, academic lectures, in-class reports, court-
room summations, and church choir programs. The sky’s the limit. Anytime
you need to stand in front of a group and present information, you can use a
PowerPoint slideshow to get your point across.

• Kiosk presentations. Presentations that run unattended, with a voiceover
soundtrack, are perfect for trade shows, department store product demonstra-
tions, Web sites, doctor’s offices—even (believe it or not) weddings and funerals.

• Interactive and Web-based tutorials, quizzes, games, and more. By adding but-
tons, links, and VBA macros, you can turn a static presentation into an interac-
tive, audience-driven program much more quickly than you could by
programming it from scratch. Examples of the kinds of interactive programs
you can create with PowerPoint include CD/DVD and Web-based tutorials,
training presentations, quizzes, games, and even software prototypes. (In fact,
Microsoft’s designers used PowerPoint to create their prototypes of the new
Office 2007 interface.)

• Printed documents. It’s not a full-fledged page-layout program like Quark-
XPress, but PowerPoint 2007 comes with templates for popular printables (like
certificates of achievement and calendars). It also gives you more control over
layout than earlier versions of the program.

• Web pages. Although PowerPoint was never a serious contender in the Web
site-creation market—and although support for creating Web pages has actu-
ally been downplayed in this version of the program—you can still optimize
and save your slides as Web pages directly from PowerPoint.

• Graphics and animations. Compared to top-notch graphics and animation
programs, the images and effects you can produce with PowerPoint 2007 may
seem limited and clunky. Still, if PowerPoint’s all you’ve got to work with—and
if you want to create a basic picture or animation—PowerPoint 2007’s got your
back.
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What’s New in PowerPoint 2007
Nearly all the changes Microsoft made to PowerPoint 2007 affect the way the pro-
gram looks and behaves; in other words, the changes affect how you do things in
PowerPoint 2007. The most sweeping of these include:

• A completely redesigned interface. The difference you notice right away is the
tabbed ribbon (Figure I-2), which replaces all of the old, pre-PowerPoint 2007
menus and toolbars. Instead of wasting time trying to remember if the option
you want is hiding on a toolbar or a menu or a pane or a dialog box or some-
where else entirely, in PowerPoint 2007, you reach all options from the ribbon.

FROM THE FIELD

When Not to Use PowerPoint
It’s easy to get caught up in all the trappings associated with
giving a presentation: the slideshow, the handouts, the
speaker notes, and so on. But you can give a fantastic,
memorable presentation without any of these supporting
tools. You—what you have to say and how you say it—are
the reason people are filing into the room, not the groovy
tent cards you figured out how to print in PowerPoint.

In fact, when supporting tools cause you to lose focus and
spend more time tweaking fonts than sharpening your logical
thrusts and persuasive parries, you’re doing more than just
wasting your time: You’re actually detracting from the overall
effectiveness of your message. PowerPoint’s supposed to
support your presentation, not be your presentation.

So before you even fire up the program, ask yourself these
questions:

• Do I really need slides? PowerPoint slides are
great for keeping key points (“Our company’s going
down in flames”) in front of your audience during
your presentation. They are also great for making
direct appeals (“Please be happy with your 50 per-
cent pay cut”). What they are not good for is deliv-
ering a bunch of dense information, such as the in-
depth analysis of the last five years’ worth of sales
activity that led to your conclusion. Also, when you
need to make only a couple of points, you may be
better off writing them on a whiteboard than using

PowerPoint. Murphy’s Law applies double when
you’re in front of a crowd: Anything that can go
wrong (computer glitch, loose cable, burned-out
projector bulb, keyboard lock-up) will go wrong.
Less technology always translates to fewer head-
aches, even with a relatively mature and stable pro-
gram like PowerPoint.

• Do I really need speaker notes? PowerPoint gives
you a way to associate notes with your presentation
that only you get to see. If you’re planning to deliver
a lengthy presentation, having your speaker notes
cued up to match your slides can save you lots of
hair-pulling. But if you’re planning a short presenta-
tion, you know your material backwards and for-
wards, or you simply prefer to use 3 × 5 cards to jog
your memory, then speaker notes may not be worth
the time it takes to set them up.

• Do I really need handouts? In PowerPoint, hand-
outs are nothing more than printouts of your slides
(although Chapter 7 shows you how to beef up your
handouts into something your audience will actually
find useful). Use handouts when you want to leave
lots of specific instructions or actionable items with
your audience. If that’s not the case, skip the hand-
outs (most of them end up in the circular file the
minute the presentation’s over anyway).
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Note: The Nostalgia Corner sidebars scattered throughout this book alert you to specific changes
between PowerPoint 2003 and PowerPoint 2007.

• New file formats. The files you’ll create in PowerPoint 2007 bear a different file
extension than the ones you created in earlier versions of the program. The
good news is that the new XML-based file formats tend to be smaller and more
recoverable than the old ones. The bad news is that you can’t edit PowerPoint
2007 files in an earlier version of the program unless you download and install a
special converter program (page 12 has details).

• Tighter integration among Office programs. Microsoft gave all of the Office
programs a face lift, not just PowerPoint. The result is that all Office programs
share similar elements. The Office button (the old File menu) appears in the
same spot in all Office programs; the steps you take to customize an Office pro-
gram are the same; and certain options—like the ones you use to create charts
and diagrams—look and behave pretty much the same way in PowerPoint as
they do in Word and Excel.

• Improved graphics. All Office programs share a single, new-and-improved
graphics engine that not only makes the charts, diagrams, and other visuals you
create in PowerPoint look better (much better), but makes them easier to cre-
ate, too (page 282).

• More look-and-feel options. PowerPoint 2007 comes with more and better-
looking templates than earlier versions of the program. In addition, Power-
Point 2007 lets you create your own reusable custom slide layouts.

• A new way to track revisions. Unfortunately, unlike earlier versions of the pro-
gram, PowerPoint 2007 doesn’t let you track the changes your reviewers make
to your presentation files. For that, you need to buy yet another Microsoft
product called SharePoint (page 439).

Figure I-2:
You can’t make the
ribbon larger, nor can
you move it around or
hide its tabs (although
PowerPoint does let you
hide the ribbon itself; see
page 394). If you’re
wondering why there’s
no File tab, it’s because
the Office button replaces
the File menu in all
Microsoft Office 2007
programs.

Office button Home tab

Font group Font dialog box
launcher

More paste
options
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A Quick Tour of the New Interface
If you’re familiar with PowerPoint 2003, the first sight of PowerPoint 2007 might
make you want to run away screaming. Where are the menus? Where are the tool-
bars? Where’s the Getting Started pane?

PowerPoint still has everything you need to create killer presentations. Stuff’s just
organized differently. After you finish this section, you may even find you like the
redesigned interface better than the original—especially if you take a few minutes
to monkey around with PowerPoint while you’re reading. Remember, the new
interface incorporates all the elements you know—buttons, menus, dialog boxes—
they’re just in different places where, more often than not, you can get to them
faster than before.

Ribbon

You can think of the ribbon as a big, fat, nonmovable toolbar. It may look as though
it’s taking up an enormous amount of room on your screen (see Figure I-2), but it
doesn’t take up any more space than the old menu bar plus a couple of toolbars.
According to Microsoft’s side-by-side comparisons, a PowerPoint 97 document with
all the toolbars visible actually appears more cramped (1008 × 575 pixels) than a
PowerPoint 2007 document with just the ribbon showing (1024 × 573 pixels). And
yet, the ribbon gives you access to every option available in PowerPoint.

Furthermore, the ribbon always appears in the same place, it never gets any bigger,
and because you can’t customize the ribbon or reposition it the way you could
toolbars in PowerPoint 2003, you can’t accidentally lose the ribbon.

Groups

When you launch PowerPoint, the Home tab automatically appears selected
(Figure I-2), which displays text formatting options organized in sections, or
groups. For example, options in the Font group of the Home tab let you bold and
underline your text; options in the Paragraph group let you align your text and
format it as a bulleted or numbered list.

Note: It may seem that Microsoft’s designers dropped the ball when they named the Home tab because
the options it offers all relate to text. Naming it Slide Text would have made more sense. On the other
hand, the ribbon’s first tab is called Home in all the Office 2007 programs, so there’s great consistency.
The tools you use most often are in the same place in every Office 2007 program.

Command buttons

As you’d expect, to select one of the options on a ribbon, just click the button. To
underline a heading, select the heading text you want to underline, zip to the Font
group, and click the Underline button. To change the color of your text, first select it,
and then head to the Font group of the Home tab and click the Font Color button.
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A tiny down-arrow icon means you can click the arrow to see additional options.
For example, clicking the down-arrow that appears beneath Paste (Figure I-2) dis-
plays a menu of paste-related options. Clicking the button (instead of the down-
arrow next to it) lets you bypass the menu and go straight to the most popular
menu command. Clicking the Paste button triggers the same result as choosing
Paste ➝ Paste: Both immediately paste the contents of the Clipboard onto your
slide.

Dialog box launchers. To give you complete control over every element of your
slideshow while sticking to their design philosophy of offering all options on the
ribbon, the PowerPoint 2007 designers placed a tiny dialog box launcher button in
the bottom-right corner of many ribbon groups. When you click a dialog launcher,
PowerPoint pops up a dialog box related to that group. Clicking the Font dialog box
launcher (Figure I-2), for example, displays the Font dialog box in Figure I-3.

Tabs

Microsoft organized the ribbon’s tabs in the order they figured most people would
create slideshows. They believe most folks begin by adding text to their slides, so
they displayed the Home tab first, followed by the Insert tab (which lets you insert
charts, diagrams, pictures, and other stuff), followed by the Slide Show tab (which
lets you rehearse your timing and record voiceover narration), followed by the
Review tab (which lets you spell-check your slideshow before sending it out for
feedback).

Note: You don’t have to select tabs in order. Most people hop back and forth from tab to tab as they add
additional text, pictures, and sounds to their slides and reformat existing material.

Figure I-3:
 If you’re familiar with PowerPoint
2003, you’ll recognize the dialog
boxes that let you customize every
aspect of your slideshow.
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Contextual tabs are tabs that let you work with specialized kinds of objects, such as
pictures or charts. They appear above the ribbon, and in this book you’ll see them
written with a vertical bar after the contextual part of the name: Chart Tools |
Format. Because showing a contextual tab such as, say, the Chart Tools | Format tab,
would do nothing but clutter up the interface if you aren’t actually trying to format a
chart, contextual tabs appear only when you need them to and automatically disap-
pear when you’re finished with them.

For example, when you select a chart on your slide, the Chart Tools | Design, Chart
Tools | Layout, and Chart Tools | Format tabs appear (see page 183, Figure 6-10).
Then, when you select a hunk of text, PowerPoint recognizes that you’re finished
formatting your chart and hides the Chart Tools tabs.

Less customization

Customization is a double-edged sword. On one hand, some folks liked being able
to make PowerPoint 2003’s interface look the way they wanted it to by adding
menu items, creating their own custom toolbars, and dragging the standard tool-
bars all over the place.

On the other hand, others hated the fact that stuff didn’t stay put. Their elbows
would accidentally graze the keyboard, or a co-worker would sit down “just to
check something,” and they’d never again be able to figure out how to draw a
dotted-line border around a text box.

PowerPoint 2007’s designers came down on the side of the “stay put” crowd. You
can customize certain things about the program, such as what appears in the sta-
tus bar and how PowerPoint saves your files (Chapter 13), but the only big thing
you can customize about the interface itself is the Quick Access toolbar shown in
Figure I-4.

Note: Microsoft hasn’t taken away the ability for developer-types to extend (add custom options to)
PowerPoint. But in PowerPoint 2007, those extensions appear in a special Add-Ins tab. What this means is
that when you install a PowerPoint 2007 add-in, you always know where to look for the newly installed
options. See Chapter 14 for more details.

Live previews

One of the coolest new things in PowerPoint 2007 is the Live Preview feature.
Imagine you want to apply a design theme to your slideshow. You click the Design

Figure I-4:
PowerPoint starts your Quick Access toolbar with just four options (shown from left to right):
Save, Undo, Redo, and Customize Quick Access toolbar. But you can delete these options,
reorder them, or add your own. You can make the Quick Access toolbar appear the same
every time you work with PowerPoint, or create a customized Quick Access toolbar for each
presentation file you work with.
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tab to see a bunch of different design-theme thumbnails (Figure I-5, top). As you
mouse over each thumbnail, PowerPoint previews the theme right there, on your
slide, by temporarily applying it to your slide’s content.

If none of those themes grabs you, you can click More to see an entire gallery of
options—each of which you can preview, live on your slide, by mousing over each
option (see Figure I-5, bottom). Live preview galleries save time and hassle by let-
ting you instantly see how an effect looks on your slide before you commit to it.
(In the old days, you had to select an option to see how it looked; then, if you
didn’t like it, you had to select Undo and start all over again.)

Note: Live previews aren’t for everybody. For one thing, galleries can appear on top of the slide element
you’re trying to modify, which means you can’t see the preview. For another thing, some folks don’t like
the idea of PowerPoint changing their slide’s appearance—even temporarily—unless they tell it to by click-
ing something. To turn off gallery previews, choose Office button ➝ PowerPoint Options ➝ Popular and
then turn off the checkbox next to Enable Live Preview.

Figure I-5:
Top: Because all of the
themes PowerPoint
offers couldn’t possibly
fit on the ribbon, the
PowerPoint designers
decided to display a
handful of the most
popular, and then add a
little More icon you can
click to see all the rest.

Bottom: The Themes
gallery, shown here, is
just one of many
galleries you find in
PowerPoint. Mousing
over a gallery option
automatically previews
that option on your slide.
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Mini Toolbar

PowerPoint 2007 did away with most of the toolbars that appeared in earlier ver-
sions of the program, but not all of them. One that remains is the pop-up Mini
Toolbar shown in Figure I-6.

Packed with popular formatting options such as bold, italics, and alignment, the
Mini Toolbar springs into action automatically each time you select text on your
slide. The Mini Toolbar duplicates formatting options you find on the Slide rib-
bon, so technically you don’t need it to get your work done. (Still, some folks find
it handy.)

Keytips

If you’re familiar with an earlier version of PowerPoint, you may recall the
Ctrl+<letter> keyboard shortcuts that appeared after most menu options. In Pow-
erPoint 2003, selecting File displayed a drop-down menu listing the Save As
option, followed by the Ctrl+S keyboard shortcut. What that meant was that to
display the Save As dialog box, you could choose File ➝ Save As, or press Ctrl+S.
Well, menus disappeared in PowerPoint 2007, but the keyboard shortcuts associ-
ated with those menus didn’t.

In addition to the old-style keyboard shortcuts, though, PowerPoint 2007 intro-
duces a groovy new way to avoid using your mouse: keytips. Keytips, shown in
Figure I-7, are tiny letters that appear next to ribbon options after you’ve pressed
Alt. They’re much like the underscores that appeared under menu options when
you pressed Alt in PowerPoint 2003, but they’re easier to spot. To see keytips, press
Alt; to hide them, press Alt again.

Figure I-6:
Technically, the Mini
Toolbar breaks the
PowerPoint 2007 design
team’s commitment not
to have stuff come out of
nowhere and then
disappear, but because
so many people spend a
lot of time formatting
text, they decided it was
worth keeping. The Mini
Toolbar appears slightly
transparent, and
disappears immediately
if you ignore it and begin
typing. You can turn it off
completely if it bugs you
(page 392 shows you
how).
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Clicking a keytip displays additional keytips. Clicking a tab keytip displays group
keytips, and clicking a group keytip displays option keytips. Here’s how it works. If
you want to show a ruler on your slide, you can click View ➝ Ruler, or you can
press Alt, then W, and then R (Figure I-7).

Improved screen tip help

In previous versions of PowerPoint, letting your mouse linger over a toolbar
option automatically displayed a curt pop-up description of the option such as
Print Preview, Spelling, or Research. But in PowerPoint 2007, mousing over a rib-
bon button displays a description that’s actually useful. See Figure I-8 for details.

Figure I-7:
Top: Just as keyboard
shortcuts let you “walk”
through menus by
pressing keys instead of
clicking your mouse,
keytips let you step
through ribbon
commands by pressing
keys.

Bottom: Clicking a tab
keytip such as W (View)
displays keytips for the
options associated with
that particular ribbon.

Figure I-8:
The screen tip help in PowerPoint 2007 shows
you expanded descriptions, outlines the
scenarios in which using the command or menu
can be useful and lists keyboard shortcuts (if
any). For more information, press F1 to display
PowerPoint’s help window with a help article
describing the option in blow-by-blow detail.
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New File Formats
The files you create using PowerPoint 2007 bear different file extensions than the
files you created using PowerPoint 2003 or an earlier version of the program. The
“x” in the new PowerPoint 2007 file names reflects the new, XML-based file for-
mat. Table I-1 shows you the differences.

The implications of the new file formats are twofold:

• Because the new file formats are based on XML, they tend to be more compact
than PowerPoint 2003. A smaller file is good news if you intend to deliver your
presentation over the Web. But in addition, the compartmentalized structure of
the new file formats makes it possible for XML-fluent developers to access and
change specific parts of a file (macros, for example) without touching the rest.
Also, these new files are easier to recreate in the event of a computer crash.

• The files you create with PowerPoint 2007 can’t automatically be edited in ear-
lier versions of the program. Fortunately, Microsoft offers a compatibility pack
that lets folks running Office 2003 open PowerPoint 2007 files; to download
and install it, visit www.microsoft.com/office/preview/beta/converter.mspx. Power-
Point 2007 also gives you the option to save files compatible with PowerPoint
2003 and earlier versions of the program (see page 46).

Also new in PowerPoint 2007 is the ability to save your slideshows in two addi-
tional file formats:

• PDF. Portable Document Format is a popular file format that gazillions of peo-
ple use to exchange read-only versions of documents over the Web. If you save
your slides as PDF files and put them up on the Web, your audience members
don’t have to hassle with downloading them and pulling them into Power-
Point. They can view your PDF slides using nothing more than Internet
Explorer and the free Adobe reader browser plug-in.

• XPS. Microsoft’s eXtensible Paper Specification is a brand-new Windows-only
file format similar to PDF. You may want to save your slides as XPS files if con-
trolling the way your slides print out is important to you.

To save files in either PDF or XPS, you first need to download and install a special
PowerPoint add-in from Microsoft. You’ll find details on page 440.

Table I-1. Old and New File Extensions for the Files You Create in PowerPoint

PowerPoint 2007 File
Extension Description

Old (pre-2007) File
Extension

.pptx Presentation .ppt

.potx Template .pot

.ppsx Show .pps

.ppam Add-in .ppa

.pptm Macro-enabled presentation .ppt
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Improved Graphics
Microsoft overhauled the part of Microsoft Office that lets you create charts, dia-
grams, and pictures in PowerPoint, Word, and other Office programs. Not only is
creating graphics easier in PowerPoint, the results, as you see in Figure I-9, are
much more impressive.

In addition, PowerPoint 2007 lets you apply sophisticated graphic effects (like
shadows, glows, and 3-D bevels) to the text and pictures on your slides with just a
couple of clicks.

More Theme Options
Like harvest-gold stoves and avocado shag carpeting, the design templates that came
with PowerPoint 2003 were beginning to show their age. So Microsoft created a
bunch of new design templates (they’re called Office themes now) that look a little
more up-to-date. Unlike the old PowerPoint-only design templates, you can apply
the Office themes to any file you create using an Office program, from a PowerPoint
slideshow to a Word document or Excel spreadsheet. (That’s good news for folks
who want to create matching backup reports in Word and matching spreadsheets in
Excel to hand out at the end of their PowerPoint presentations.) Also new in Power-
Point 2007 is the ability to create multiple slides with the same layout faster with
reusable slide masters (Chapter 5).

Figure I-9:
Top: The charts and
other graphics you could
create using PowerPoint
2003 got the point
across, but they weren’t
exactly what you’d call
inspiring.

Bottom: Not only do
graphics look great out
of the box in PowerPoint
2007; you can change
the way they look with
the click of a button by
applying professionally
designed Quick Styles.
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A New Way to Track Revisions
Microsoft opted to drop revision tracking in PowerPoint 2007. That means when
you need to collaborate with co-workers to create a presentation, you have two
choices:

• Do it yourself. If you work with a small team, you can eyeball your reviewers’
changes and integrate them into your PowerPoint presentation yourself.

• Purchase the Microsoft Office SharePoint Server (MOSS). If you work for a big
organization, your computer may already be hooked up to a MOSS already. In
that case, you can use it to define a workflow for your presentation (which folks
need to review it next and how long you’re giving them to get back to you),
control access to your presentation, and track revisions. (If your organization
hasn’t already purchased a MOSS, of course, Microsoft is hoping that it will.)

The Very Basics
You’ll find very little jargon or techno-geek terminology in this book. You will,
however, encounter a few terms and concepts that you’ll encounter frequently in
your computing life:

• Clicking. This book gives you several kinds of instructions that require you to
use your computer’s mouse or trackpad. To click means to point the arrow cur-
sor at something on the screen and then—without moving the cursor at all—to
press and release the clicker button on the mouse (or laptop trackpad). To dou-
ble-click, of course, means to click twice in rapid succession, again without
moving the cursor at all. To drag means to move the cursor while pressing the
button continuously. To right-click, click as described above, but press the
mouse button on the right.

When you see an instruction like Shift-click or Ctrl-click, simply press the key as
you click.

• Keyboard shortcuts. Every time you take your hand off the keyboard to move
the mouse, you lose time and potentially disrupt your creative flow. That’s why
many experienced computer fans use keystroke combinations instead of menu
commands wherever possible. Ctrl+B is a keyboard shortcut for boldface type
in PowerPoint 2007 (and most other programs). When you see a shortcut like
Ctrl+S, which saves changes to the current document, it’s telling you to hold
down the Ctrl key, and, while it’s down, type the letter S, and then release both
keys. When you see Alt+F, S (the newer Save keyboard shortcut), press Alt, then
F, and then S.

• All roads lead to Rome. PowerPoint 2007 usually gives you several ways to
choose the same option—by clicking a ribbon option, by right-clicking an
object on a slide and then choosing from the shortcut menu that appears, or by
pressing a series of keys. Some folks prefer the speed of keytips; others like the
satisfaction of a visual command array available in menus or toolbars. This
book lists the alternatives so that you experiment to see which you like best.
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About This Book
PowerPoint was never exactly known for its wonderful documentation. And while
the whole point of PowerPoint 2007’s radical interface overhaul was to make the
program easier to use, “easier” doesn’t mean you’re going be able to sit down with
the new program and bat out a presentation without some help. Fortunately, there
is help—and you’re holding it in your hands.

This is the book that should have come in the PowerPoint box. It explains all the
ribbons and options and shows you step-by-step how to create slideshow from
scratch. You’ll learn tips and shortcuts for making PowerPoint easier to work with,
as well as guidelines for making your slideshows support your presentation (as
opposed to letting it take over your presentation).

PowerPoint 2007: The Missing Manual is designed for readers of every skill level
except super-advanced VBA programmer. If PowerPoint 2007 is the first presenta-
tion program you’ve ever used, you’ll be able to dive right in using the explana-
tions and examples in this book. If, on the other hand, you’re familiar with
PowerPoint 2003 or an earlier version of the program, you’ll find this book a use-
ful reference for mapping how you created an element in your previous program
to how you do it in PowerPoint 2007. “Design Time” boxes contain practical
advice for preventing powerpointless presentations. And while the VBA program-
ming language is far too broad a subject to cover in detail in this book, you do get
tips on where to go for a more in-depth look at using VBA to create macros.
(Microsoft pulled the plug on the macro recorder in PowerPoint 2007, so pro-
gramming VBA is now the only way to create macros.)

About the Outline
PowerPoint 2007: The Missing Manual is divided into four parts, each containing
several chapters:

• Part 1: Slideshow Basics guides you through the creation of your very first slide-
show in PowerPoint 2007, from adding and editing text, basic charts, diagrams,
and tables, to reordering slides and creating reusable slide masters.

• Part 2: Presenting Your Slideshow outlines your options for getting your slide-
show in front of your audience. You’ll see how to run presentations onscreen
and on an overhead projector; package them up for display on a kiosk or the
Web; and how to convert PowerPoint presentation files into other file formats.
You’ll also learn everything you could ever want to know about printing slides,
speaker notes, and handouts.

• Part 3: Beyond Bullet Points: Multimedia, Animation, and Interactivity shows
you how to add pictures, spreadsheets, sound and video clips, and macros to
your slides to create compelling, audience-controlled presentations. You’ll learn
how to draw on your slides, record voice-over narration, add professional-look-
ing slide transitions, and display clickable links from your slides to Web pages
and other programs.
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• Part 4: Working Faster and More Effectively focuses on customizing Power-
Point and collaborating with others. You see how to set hard-to-find Power-
Point options, how to install add-ins, and how to keep your PowerPoint files
secure as you pass them around for review.

About ➝ These ➝ Arrows
Both throughout this book specifically and the Missing Manual series as a whole,
you’ll find sentences like, “Click Start ➝ All Programs ➝ Microsoft Office ➝

Microsoft Office PowerPoint 2007.” Consider this shorthand to save you lots of
extra words to describe how to get there—to a specific file or program or feature—
from where you are. Otherwise, you’d have to read through, “Click on this button,
and then choose this menu, then scan through the options on this sub-menu to
find this which helps you get to this place over there.” You’ve got better things to
do with your time than read all those extra words—like putting together the next
Great American presentation.

PowerPoint Examples
As you read the book’s chapters, you’ll encounter a number of step-by-step tutori-
als. You can work through them using any PowerPoint document of your own, or
just begin a new PowerPoint document and start fresh.

About MissingManuals.com
At the missingmanuals.com Web site, you’ll find articles, tips, and updates to this
book. In fact, you’re invited and encouraged to submit such corrections and
updates yourself. In an effort to keep the book as up-to-date and accurate as possi-
ble, each time we print more copies of this book, we’ll make any confirmed correc-
tions you’ve suggested. We’ll also note such changes on the Web site, so that you
can mark important corrections into your own copy of the book, if you like. (Click
the book’s name, and then click the Errata link, to see the changes.)

In the meantime, we’d love to hear your own suggestions for new books in the
Missing Manual line. There’s a place for that on the Web site, too, as well as a place
to sign up for free email notification of new titles in the series.

Safari® Enabled
When you see a Safari® Enabled icon on the cover of your favorite
technology book, that means the book is available online through the
O’Reilly Network Safari Bookshelf.

Safari offers a solution that’s better than e-books. It’s a virtual library that lets you
easily search thousands of top tech books, cut and paste code samples, download
chapters, and find quick answers when you need the most accurate, current infor-
mation. Try it for free at http://safari.oreilly.com.
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Creating a Basic
Presentation

PowerPoint 2007 is the great equalizer. Even if you’re familiar with previous ver-
sions of PowerPoint, when it comes to PowerPoint 2007 you’re pretty much in the
same boat as someone who’s never even heard of presentation software. That’s
because the entire PowerPoint interface has changed. As you saw in the Introduc-
tion, Microsoft has done away with toolbars, renamed and reorganized menu
options, and even axed a couple of features.

Fortunately, the new interface makes quite a bit of sense once you get used to it.
That’s what this chapter is for: to familiarize you with PowerPoint 2007 by walking
you through the creation of a basic bullets-and-background slideshow presentation.
You’ll learn how to create a new slideshow, choose a look and feel, add text and
slides, print speaker notes and handouts, and finally, how to unveil your masterpiece.

Note: Part 3 shows you how to jazz up your basic slideshow with diagrams, charts, sounds, animations,
and more.

Beginning a New Presentation
You’ve got two basic choices when it comes to creating a new presentation:

• You can start from scratch, using a blank canvas. If you’re familiar with earlier
incarnations of the PowerPoint program, or if you’re interested in learning the
ins and outs of PowerPoint quickly, then you’ll probably want to choose this
option. (As daunting as “from scratch” sounds, you don’t have to do all the
work yourself; page 33 shows you how to apply a canned look and feel—or
theme—to your new presentation.)
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• You can create a new presentation based on an existing template, theme, or
presentation. A template is a generic presentation file designed for you to reuse.
Complete with themes (see the box on page 28), background images, and even
generic content (such as page numbers and placeholder text), templates let you
jump-start your presentation by giving you everything you need except your
specific content. If you’re creating a presentation for your local school board,
for example, then you’ll need to add the content that describes your findings,
conclusions, and suggestions.

Templates are the better option when you need to crank out a presentation in a
jiffy. PowerPoint comes with a handful of professionally designed templates and
themes, but you can also create presentations based on a template, theme, or
presentation that you’ve previously created, or one that you’ve found online
and downloaded onto your computer.

PowerPoint divides these two basic choices into six specific options that are based on
whether you want to piggyback your new presentation on an existing template,
theme, or presentation. When you fire up PowerPoint and select Office button ➝

New, you see the following six choices for creating a presentation, each of which is
described in detail in the following sections:

• Blank and recent. Lets you create either a blank presentation or a presentation
based on one of the themes or templates you recently applied to a PowerPoint
presentation.

• Installed Templates. Lets you create a presentation based on one of the handful
of generic templates that comes with PowerPoint, such as Classic Photo Album
or Corporate Presentation.

• Installed Themes. Lets you create a presentation based on one of the canned
look and feel options that comes with PowerPoint, such as Apex, Metro, or
Opulent.

• My templates. Lets you create a presentation based on a template that you cre-
ated, or that you downloaded from the Web.

• New from existing. Lets you load an old presentation into PowerPoint 2007,
make changes, and save the newly changed presentation using a new filename.

• Microsoft Office Online. Lets you hunt for professionally designed templates
and themes on Microsoft’s Web site.

Creating a New Presentation from Scratch
When you launch PowerPoint, the program starts you off with a brand-new pre-
sentation cleverly named Presentation1 (Figure 1-1).

Typically, you dive right in, adding a look and feel (page 33), text, pictures, and so
on to the blank presentation PowerPoint hands you. But if you’ve closed or saved
your freebie, here’s how you create an additional blank presentation:
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1. Select Office button ➝ New.

The New Presentation window (Figure 1-2) appears.

2. On the left side of the New Presentation window, make sure the “Blank and
recent” option is selected.

If it’s not, click it to select it.

NOSTALGIA CORNER

Good-Bye, AutoContent Wizard
Clear back in 1994, as part of PowerPoint 4—spurred by
reports that thousands of folks were firing up PowerPoint
and then just sitting there sipping coffee while they stared
at the screen, unsure of how to proceed—Microsoft
debuted a feature called the AutoContent wizard. The Auto-
Content wizard asked a series of questions, beginning with
what type of presentation you wanted to create, such as
“Communicating Bad News” or “Project Post-Mortem”.
Then, based on your answer, it suggested possible titles,
bullet points, and so on. The result: a quick-and-dirty pre-
sentation for next to no effort.

Some folks loved the AutoContent wizard. Others blamed it
for the fall of Western civilization, insisting it was responsi-
ble for millions of boring, cookie-cutter presentations
devoid of meaning. Whether or not those accusations
affected Microsoft’s decision to pull the AutoContent wizard
from PowerPoint 2007 is anyone’s guess. But pull it they
did, leaving you just two options for creating a new presen-
tation: from scratch, or from an existing template, theme, or
presentation, as described in this chapter.

Figure 1-1:
PowerPoint calls this a
“blank” presentation
even though technically
it’s not blank at all: It
contains placeholders for
the first slide’s title and
subtitle. Page 33 shows
you how to change the
Office theme that
PowerPoint hands you to
something more colorful
and more artfully laid
out.
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3. In the New Presentation window, double-click Blank Presentation (see
Figure 1-2). Or you can click Blank Presentation and then click Create.

Either way, a new blank presentation named Presentation2 (or Presentation3,
or Presentation4 depending on how many new presentations you’ve created
since you launched the program) appears in your PowerPoint workspace.

Tip: To create a new blank presentation without going through the New Presentation window, press
Ctrl+N.

To find out how to add content and design elements to your newly created pre-
sentation, zip down to page 34. Page 46 shows you how to save your new
presentation.

Creating a Presentation from an Existing Template, Theme,
or Presentation
PowerPoint lets you get a jump on your new presentation by starting with an exist-
ing template, theme, or presentation and then filling in your content. You can
choose from the many templates and themes that come with PowerPoint, or you
can go online and search for a specific template or theme that matches your needs.
You can also reuse any of the templates, themes, or presentations that you (or your
co-workers) have previously created. The following sections describe each of your
options.

From an existing template

A template is a generic presentation designed (by Microsoft, by a third-party ven-
dor, by you, or by whoever created the template) to be used again and again. Tem-
plates help you crank out presentations quickly, because all the design work has

Figure 1-2:
Because folks typically
want to create a new
presentation either from
scratch or based on a
favorite (and, therefore,
recently used) template,
the “Blank and recent”
option is automatically
selected. But you can
choose instead to create
a presentation based on
an existing presentation,
or on a theme or
template you’ve created
or downloaded from the
Web.
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been done for you. All you have to do is add your content: the text, charts, graph-
ics, and other elements that convey your particular message.

Templates vary widely, but all contain predefined themes (color schemes, back-
ground images, title and bullet point layouts, and text fonts). Some templates con-
tain additional format and design elements and even some generic or placeholder
content. Some templates are businesslike, with sober colors and artwork; some are
whimsical, with wacky fonts and brightly colored balloons all over the place. The
template motifs you can find are nearly endless, which makes it relatively easy to
choose a template that fits the mood and structure you want to create for your
presentation.

PowerPoint gives you four different options for creating a new presentation using
an existing template: Recently used templates, Installed Templates, “My tem-
plates” (templates you’ve created yourself), and Microsoft Office Online. The
option you choose depends on where you want PowerPoint to hunt for the tem-
plate, as described in the following sections.

Recently used templates. PowerPoint keeps track of the templates you apply to
your presentations and displays the last few in a list. So if you tend to use the same
two or three templates to create all your presentations, chances are you’ll find this
option the easiest.

Here’s how to create a new presentation using a template you recently applied to
another presentation:

1. Select Office button ➝ New.

The New Presentation window appears.

WORD TO THE WISE

The Trouble with Templates
The downside to using PowerPoint’s pre-built templates is
that you can end up with a presentation that looks exactly
like the one Bob in Accounting presented last week. If that
happens, then not only do you look bad, but your audience
may tune out, assuming they’ve heard the same message
before.

Another potential downside to using templates is that you
may be tempted to shoehorn your presentation into the
template—which is almost never a good idea.

On the other hand, tons of graphic designers sell Power-
Point templates on the Web, so if you look hard enough—
or spend the time to create your own template—you should

be able to come up with something both original and
appropriate.

Just keep in mind that to create an effective presentation,
you need to focus first and foremost on your message, and
then choose a template (or a theme, which are described
on page 28) that supports your message. You may also
want to consider tweaking the template—adjusting the font
or replacing the background image with a tasteful gradient,
for example—both to fit your message and to help ensure
your presentation is as original and memorable as you are.
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2. In the left side of the New Presentation window, make sure the “Blank and
recent” option is selected. (If it’s not, click to select it.)

3. In the middle of the New Presentation window, scroll through the template
thumbnails.

Tip: Mousing over a template briefly displays the location of the template (for example, C:\Program
Files\Microsoft Office\Templates\QuizShow.potx for a built-in template stored on your computer, or
“Office Website” for a template located on Microsoft’s Web server). You might find this information useful
if, for example, you’re hunting for a template you remember finding online.

4. Click to select the template you want to base your new presentation on.

In the right side of the New Presentation window, a preview appears (see
Figure 1-3). Depending on whether the selected template is stored on your
computer or on Microsoft’s Web server, PowerPoint displays a Create or
Download button, respectively, at the bottom of the New Presentation window.

5. Click Create (or Download).

The New Presentation window disappears. (If you clicked Download, then a
Downloading Template message flashes briefly on the screen.) PowerPoint then
loads the selected template into a new presentation it names Presentation1 (or
Presentation2, or Presentation3, depending on how many presentations you’ve
created since you launched PowerPoint).

Installed templates. When you installed PowerPoint, you automatically installed a
handful of professionally designed templates, including templates that let you set
up photo albums (Classic Photo Album and Contemporary Photo Album), corpo-
rate-style slideshows (Corporate Presentation), layouts for print publications
(Pitchbook), animated question-and-answer tutorials (Quiz Show), and big-screen
slideshows (Wide Screen Presentation 16 × 9).

Figure 1-3:
To see a larger version of
a tiny template
thumbnail—as well as to
display any available
identifying information,
such as the template’s
file size and popularity
rating—simply click to
select the template.
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To use one of these built-in templates to create a new presentation, follow these
steps:

1. Select Office button ➝ New.

The New Presentation window appears.

2. In the left side of the New Presentation window, click Installed Templates.

Several template thumbnails appear in the middle of the New Presentation
window.

3. Click a template to select it.

A larger version of the template appears in the preview area (the right side) of
the New Presentation window.

4. Click Create.

The New Presentation window disappears, and you see a new presentation file
based on the template you selected. Figure 1-4 shows you an example.

Tip: Instead of clicking a template and then clicking Create, you can save a step by simply double-clicking
the template.

My templates. Each time you create your own template (page 48) or download a
template from Microsoft’s Web site (page 27), PowerPoint automatically stores the
template in a special directory on your computer similar to this one: C:\Documents
and Settings\[Your Name]\Application Date\Microsoft\Templates.

Figure 1-4:
Templates are nothing
more than presentations
for which someone (the
template author) has
defined Slide and Title
masters. Masters, which
you’ll learn all about in
Chapter 5, define the way
your slides look overall
(like this crisp, clean
background) as well as
the way your text looks
(the color and font).
Templates also typically
include helpful slide
layouts and content, like
the attractive section
headings and
replaceable text shown
here.
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Note: PowerPoint controls where you store the templates you download from Microsoft’s Office Online
Web site, and it suggests where to store the templates you create from scratch. But if you bypass
Microsoft’s Office Online Web site and download a template from another Web site—or if you override
PowerPoint’s suggestion of where to store a template you create from scratch—then you won’t be able to
reuse these rogue templates using the steps described in this section. Instead, you want to follow the
steps you find on page 29 for creating a new presentation from an existing presentation file.

To use one of these templates to create a new presentation, follow these steps:

1. Select Office button ➝ New.

The New Presentation window appears.

2. On the left side of the New Presentation window, click “My templates.”

The New Presentation window vanishes, and the New Presentation dialog box
shown in Figure 1-5 appears.

3. In the New Presentation dialog box, select the template you want to use and
click OK.

The New Presentation dialog box disappears, and PowerPoint displays a new
presentation file based on the template you selected.

Online. Although lots of Web sites offer PowerPoint templates for download, you
should check Microsoft’s Office Online Web site first for a couple of reasons. One,
Microsoft’s templates are free; and two, checking Microsoft’s site is one-click easy,
as described next.

Figure 1-5:
PowerPoint stores the
templates you create—or
that you download from
Microsoft’s Office Online
Web site—in a special
folder so that you won’t
confuse them with
PowerPoint’s built-in
templates. To change
how the template icons
appear, choose from
Large Icons (which
makes the template
names easier to read),
List (shown here), and
Details (which displays
the date the template
was created).
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Tip: Because Microsoft lets its customers upload templates willy-nilly, the quantity and quality of the
templates you find on its site can vary widely. Figure 1-6 shows how to weed out customer-submitted
templates, leaving only those designed by official Microsofties.

1. Select Office button ➝ New.

The New Presentation window appears.

2. On the left side of the New Presentation window, under Microsoft Office
Online, choose the type of template you’re looking for, such as Brochures or
Content Slides.

Template thumbnails appear in the center of the New Presentation window
(Figure 1-6).

3. Click a template thumbnail to select it; then click Download.

A validation message box appears, letting you know that Microsoft is gearing up
to check your copy of PowerPoint to make sure it’s not bootlegged. (If
Microsoft doesn’t find a legitimately purchased copy of PowerPoint on your
computer, then you won’t be able to download templates.)

4. In the validation message box, click Continue.

Microsoft checks out your copy of PowerPoint. If it passes muster, a Download-
ing Template message appears briefly, after which PowerPoint displays a new
presentation file based on the template you selected.

Figure 1-6:
For finer control over the
templates you see, select
Rating Sort (which
displays the most
popular templates first,
as determined by other
PowerPoint fans), Name
Sort (which displays
named templates in
alphabetical order),
Show Customer
Submitted (which
displays all templates,
including the ones other
PowerPoint folks have
uploaded), or Hide
Customer Submitted
(which shows only those
templates created by
Microsoft).

Sort by customer rating

Sort by name

Show customer submitted
templates

Hide customer submitted
templates
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The rest of this chapter shows you how to add text and change the look of your
newly created presentation.

From an existing (built-in) theme

If you know which theme you want to apply to the new presentation you’re creat-
ing, then you can save a click or two by applying it when you create the presenta-
tion file. (The alternative is to create the presentation file and then apply the
theme, as described on page 33.)

Note: PowerPoint only lets you apply PowerPoint-supplied themes when you create a presentation. If
you’ve created your own theme or downloaded one from the Web, then you need to create your presen-
tation first and then apply the theme (see page 33).

To create a new presentation based on one of the themes that comes with Power-
Point:

1. Select Office button ➝ New.

The New Presentation window appears.

2. On the left side of the New Presentation window, click Installed Themes.

Several theme thumbnails appear in the middle of the New Presentation
window.

3. Click a theme to select it.

A larger version of the theme appears in the preview area (the right side) of the
New Presentation window.

NOSTALGIA CORNER

Out with Color Schemes, In with Themes
Earlier versions of PowerPoint let you customize your pre-
sentations using design templates and color schemes.

But in PowerPoint 2007, your customization choices have
changed: now you’re working with templates and themes.

• Templates in PowerPoint 2007 are similar to the
design templates found in pre-2007 versions. A tem-
plate is any presentation you plan to reuse. You tell
PowerPoint—and remind yourself and your cowork-
ers—that you plan to reuse it by saving it in the spe-
cial template file format, .potx. Templates typically
define custom slide layouts and, in some cases,
generic content. Every template has a theme.

• Themes in PowerPoint 2007 are more accurately
referred to as Office Themes, since you can use the
same .thmx theme files in Microsoft Word and
Microsoft Excel as you can in PowerPoint. A theme
tells PowerPoint what color to use for your slides’
titles, subtitles, body text, background, and so forth.
It also describes which fonts and graphic effects to
use; for example, some themes automatically add
shadows to title text and blurring to the shapes you
add to your slides.
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4. Click Create.

The New Presentation window disappears and you see a new presentation based
on the theme you selected. Figure 1-7 shows you an example.

Tip: Instead of clicking a theme and then clicking Create, you can save a step by simply double-clicking
the theme.

From an existing presentation

If you’ve already got a presentation on your computer—created in any version of
PowerPoint—then you can load that presentation into PowerPoint 2007 and use it
as the basis of a new presentation.

You’ve got two options for loading an existing presentation: the Existing Presenta-
tion window, which is a good choice if you’ve never used PowerPoint before; and
the Open window, which is handy if you’re familiar with PowerPoint.

Note: A third, quickie alternative exists for creating a new presentation from an existing one—but this
alternative works only if you’ve recently edited the existing presentation. To try it out, click the Office but-
ton and then, from the list of Recent Documents that appears, choose an existing document. After Power-
Point opens the document, immediately save it (Office button ➝ Save As) with a different name.

The New from Existing Presentation window

If you’re new to PowerPoint, then you’ll appreciate the New from Existing Presen-
tation window, which simplifies the process of opening an existing presentation.
And unlike using the Open window, using the New from Existing Presentation
window automatically generates a new file name, so you don’t have to worry about
accidentally overwriting your original presentation.

Figure 1-7:
Unlike applying a
template to a newly
created presentation,
applying a theme doesn’t
start you out with custom
slide layouts or content.
Instead—as you can see
by the single slide shown
here—themes give you
coordinated color, font,
and background effects.
PowerPoint automatically
applies these effects to
each new slide you
create.
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To create a presentation using the New from Existing Presentation window:

1. Select Office button ➝ New.

The New Presentation window appears.

2. Click “New from existing.”

The New from Existing Presentation window appears.

3. Select the file you want to open, as described in Figure 1-8, and then click Cre-
ate New.

The New from Existing Presentation window disappears, and the presentation
you selected appears in your PowerPoint workspace. PowerPoint gives the pre-
sentation a new, generic name (PowerPoint2, PowerPoint3, and so on) to
remind you to rename the file before you save it. (Page 46 shows you how to
rename files.)

Note: Creating a new presentation from an old one is very similar to creating a new presentation from a
template, as you saw on page 22.

The Open window

The Open window gives you more options for opening an existing presentation
than the New from Existing window does. You’ll find these options useful in cer-
tain situations, such as when you want to protect an existing presentation by open-
ing it in read-only mode, read through all the slides to make sure it’s the one you
want, and then save a copy.

Figure 1-8:
To browse your computer
for an existing
PowerPoint file, either
click the folder icons you
see on the left side of the
window, or click the
“Look in” drop-down
menu. When you see the
PowerPoint file you’re
looking for, click it to
select it. Then click Create
New to load it into
PowerPoint under a new
name.
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To open an existing presentation using the Open window:

1. Choose Office button ➝ Open (or press Ctrl+O).

The Open window shown in Figure 1-9 appears.

2. Select the file you want to open, either by clicking the folder icons you see on
the left side of the window, or by clicking the “Look in” drop-down menu.
When the PowerPoint file you’re looking for appears in the list, click it to
select it.

Tip: To see a preview of each file on the right side of the Open window as you select it, click the Open
window’s Views icon (Figure 1-9) and select Preview.

3. Choose one of the following options:

• Open. Opens the selected file.

• Open ➝ Open Read-Only. Opens a protected version of the file that lets you
make changes to the presentation, but doesn’t let you save them unless you
specify a new filename.

• Open ➝ Open as Copy. Opens the presentation file, but renames it
Copy(1)filename.pptx.

• Open ➝ Open in Browser. Opens the selected HTML file in Internet
Explorer (or your default browser).

• Open ➝ Open and Repair. Tells PowerPoint to fix a corrupted file before it
tries to open it.

The file you selected appears in your PowerPoint workspace.

Figure 1-9:
To open a file quickly,
double-click it (instead
of selecting it and then
clicking Open or one of
the Open options).

Views


